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1. FB004 Robotic Platform Overview 
This manual will explain how to assemble and configure your FiveBOT robot.  Please take 
your time to carefully read through this manual. 
 

The FiveBOT004 Two Wheel robotic platform is designed for researchers and students 
working on robotic development. 
 
The FiveBOT004 Two Wheel robotic platform comes with 1castor wheel and 2 wheels 
controlled by 2 DC motors, allowing rotation and movement in any direction. Three infrared 
rangefinders allow the FB004 to track and chase objects, follow walls, and avoid obstacles 
in 360 degrees.  
 
The FiveBOT004 Two Wheel robotic platform’s maximum of load capacity is 10kg which 
can be placed on the extra module on top of the platform. 
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2. FB004 2WD Parts List 
ID  Part Number  Part Name  QTY  Accessories  

1  12032  Bottom chassis  1   
2  20001  Bumper Sensor  3   
3  12003  Battery mounting plate  1   
4  12004  Castor Wheel  1   
5  12005  Castor mounting bracket  1   
6  14002  Wheels  2   
7  18005  Wheel Hub Assembly  2   
8  12041  Motors mounting bracket  2   
9  16002  DC Motors  2  With encoders and cables  

10  12042  Supporting pillar  4   
11  12033  Second layer mounting plate  1   
12  12011   Ultrasonic Mounting Kit  2   
13  12034  Top chassis side bracket  2   
14  12035  Top chassis  1   
15  12014  Servo Pan/Tilt Bracket  2   

16  12012  Sensors mounting bracket  2   

17  12015  Ultrasonic/Infrared Mounting Kit  6   

18  12016  Ultrasonic rubber grommet  16   
19  95002  Hex Screwdrivers  1  4 pieces set  
20  95003  Spanner  1  8-10mm  

21  80013  M4*8 steel Hex Socket Head Cap Screw  22   

22  80002  M5*12 steel Hex Socket Head Cap Screw  12   

23  80003  M6*15 steel Hex Socket Head Cap Screw  4   

24 80010 GP2Y0A21 Infrared Cable  & Screws 3  

25 

 
12040 Power switch Charging Socket  1  

One Main Power switch, One 
Charge Socket, One Power 

switch  
26  80006  Wheel Hub Screws Bag  1   

3. Electronic Components in FB004 2WD 

ID 
Part 

Number 
Part Name QTY Accessories 

1 22002 Arduino Board, Atmega328 1  

2 22004 Arduino Expansion V1.1 1  

3 20012 Dual Ultrasonic Sensor Module 3  

4 76001 NI-MH Battery 12V 1800mAh 1  

5 76002 NI-MH Battery Charger, 500mA 1  

6 20014 GP2Y0A21 Infrared Module 3  

7 71003 Bumper Cable 3  

8 71001 Motor Encoder Cable 2  

9 71005 Arduino USB Cable 
1 
 

  

10  80004  M4*8 FHCS  42   
11 80011 Ultrasonic Cable & Screws 3  

12 71005 Arduino USB Cable 1   

13 80005 Controller Screws Bag 1   
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4. FB004  2WD Chassis Construction  
Welcome to your new FiveBOT004 2 Wheel Drive Robotic Platform! 
Please take a moment to remove all of chassis parts from the box and 
check all of parts against the parts list before commencing assembly. 
 
Please note: A Phillips head screwdriver is required for assembly and is 
not included.  
 
Step 1.  Check all parts and tools. 

 
Step 2. First lay down the bottom 
chassis (part #12032) 

 
Step 3. Attach castor wheel (part 
#12004) to castor mounting bracket 
(part #12005) using 4 x M6*15 
hexagon screws (part #80003) 
(continued on next page). 
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Note: Please pay close attention to 
the orientation of the screws as 
shown to the right.  If the screws are 
driven in the wrong way, the body of 
the screw will interfere with the 
castor wheel movement.  
Additionally, the flat washer must be 
placed be placed beneath the head 
of the screw and the split washer 
beneath the nut.        
Step 4. Mount castor wheel bracket 
onto the bottom chassis using 8 x 
M5*12 hexagon screws (part 
#80002). 

 
Step 5. Take out 2 x motor 
mounting brackets (part #12041) 
and 8 x M5*12 hexagon screws 
(part #80002). 
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Step 6. Screw the motor mounting 
brackets onto the bottom chassis as 
shown. 

     
Step 7. Take out 2 x DC motors 
(part #16002). 

 
Step 8. Screw the DC motors onto 
motor brackets using the small 
black screws contained within the 
Wheel Hub Screws Bag (part 
#80006).  Please take care that the 
encoders are screwed in with the 
green circuit board facing upwards. 
 
Note:  The DC motors will need to 
be screwed in using a Phillips head 
screwdriver. Tighten each screw 
one at a time until the motor has 
come through the bracket as far as 
it can.  The DC motor needs to be 
installed flush against the inside of 
the bracket – if it’s not, the motor 
may not move properly. 

    

   

Step 9. Take out couplers from 
Wheel Hub Assembly bag (part 
#18005) and screw these onto the 
DC motors using the small black 
screws from Wheel Hub Screws 
bag (part #80006).  These are 
installed using the smallest hex 
screwdriver.     



 Fivebro International Corp. 
7 

Step 10. Take out the 8 x silver 
screws contained within the Wheel 
Hub Screws bag (part #80006) and 
screw them into the coupler as 
shown. 

 
Note: At this stage you should be 
able to turn the DC motor by hand.  
If not, please return to the note in 
Step 8.  You may optionally loosen 
the small brass-colored screw on 
the DC motor encoder 1/2 a turn 
(pictured right). 

 
Step 11. Attach the wheels to the 
lower chassis using the wheel hubs 
and large hexagon screws 
contained within the Wheel Hub 
Screws bag (part #80006). 

 
Step 12. Take out battery mounting 
plate (part #12003), then mount the 
12V NI-MH battery onto the bottom 
chassis as shown. 

 
Step 13. Take out 3 x bumper 
sensors (part #20001). 
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Step 14. Screw bumper sensors 
onto the front of bottom chassis 
using 6 x M4*8 hexagon screws 
(part #80013).   

 
Step 15. Take out the 2 x Sensor 
mounting brackets (part #12011). 

 
Step 16. Mount the 2 x sensor 
mounting brackets onto bottom 
chassis using 4 x M4*8 hexagon 
screws (part #80013). 

 
Step 17. Take out the 4 x 
supporting pillars (part #12042). 

 
Step 18. Lock 4 x supporting pillars 
to form a square shape as shown 
using M4*8 hexagon screws (part 
#80013). 
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Step 19.  Take out the following 
parts: 
 Top chassis side bracket (#12034) 
 Servo pan/tilt bracket (#12014) 
 Sensor mounting bracket 

(#12012) 

 Ultrasonic/infrared mounting kit 

(#12015).   

 
Step 20. Assemble sensor mounting 
plates as shown using M4*8 FHCS 
(part #80004) and rubber grommets 
(part #12016). 

 
Step 21. Add remaining rubber 
grommets to sensor brackets on 
chassis. 

 
Step 22.Take out the Dual 
Ultrasonic Modules (part #20012) 
then add the screws and spacers 
contained within the Ultrasonic 
Cable & Screws package (part 
#80011).  

      
Step 23.  Repeat this for the 
infrared sensors (part #20011).  Use 
the screws contained within the 
GP2Y0A21 Infrared Cable & 
Screws package (part #80010). 

 

Step 24. Add the ultrasonic and 
infrared sensors to the sensor 
mounting brackets assembled in 
Step 20.   
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Step 25. Add power switch charging 
socket (part #12040) to second 
layer mounting plate (part #12033).  

   
Step 26. Screw sensor brackets 
onto second layer mounting plate 
using M4*8 FHCS (part #80004). 
Please note: The ultrasonic and 
infrared (IR) sensors should be 
mounted at the opposite end to the 
power switch. 

     

Step 27. Add cables to ultrasonic 
and infrared sensors.  Please make 
connections as indicated by the 
blue and red colored dots (connect 
red to red and blue to blue).  The 
white dot will be connected to the 
Arduino Expansion Board in the 
next section of the manual. 
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Step 28.  Add cables to DC motor 
and bumper sensors.   
 
Note: Please pay close attention to 
the white clips on all of these plugs 
to ensure they are not plugged in 
upside down. 
 
 

     

     
Step 29.  Add top chassis side 
brackets to the second layer 
mounting plate using M4*8 FHCS 
(part #80004).  Please ensure that 
these screws are driven in the 
direction of the red arrow shown. 

    
Step 30.  Attach the Arduino control 
board (part#22003) to the bottom 
chassis using the screws and 
spacers contained within the 
Controller Screws Bag (part 
#80005). 
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Step 31.  Add second layer 
mounting plate onto bottom chassis 
using M4*8 hexagon screws (part 
#80013). 

 
Step 32.  Take out top layer (top 
chassis part #12035) 

 
Step 33.  Screw on the top layer 
and your chassis building is now 
complete!  
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5. Sample Wiring Installation 
 
Subsequent assembly instructions will make references to this figure. 
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The diagram below illustrates one example of how to connect the Arduino control board to 
the sensors, motors and battery. Please pay particular attention to the battery connections. 
Wiring these incorrectly will cause damage to the controller.  Please note the wire colors 
used in the diagram. 
 
Please note:  Some newer models of the 2WD robotic platform may be shipped with 
different wire colors.  Bumpers:  Black  brown, red  red, green  pink.  IR Sensors:  
Green  blue, red  Green, black  yellow. 
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Please note: This wiring sample corresponds to the FB004 v1.0 example code found on 
the Fivebro website and on the CD included in this package. 

 
By uploading your own code or modifying the example code, pin numbers may change and 
you will need to make your connections accordingly. 

 

6. Arduino control board & sample code 
 
 

Introduction 

The FB004’s Arduino control board is a specially modified Arduino control board designed especially for robotics 

applications.  Built from the Arduino open source platform, it is supported by thousands of open source codes and can be 

easily expanded with most Arduino Shields. The integrated 2 way DC motor driver and wireless socket gives you a much 

easier way to start your robotic project. 
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Specification 

 Atmega328 microcontroller 

 14 Channels Digital I/O 

 6 PWM Channels (Pin11,Pin10,Pin9,Pin6,Pin5,Pin3) 

 8 Channels 10-bit Analog I/O 

 USB interface 

 Auto sensing/switching power input 

 ICSP header for direct program download 

 Serial Interface TTL Level 

 Supports AREF 

 Supports Male and Female Pin Header 

 Integrated sockets for APC220 RF Module 

 Five IIC Interface Pin Sets 

 Two way Motor Driver with 2A maximum current 

 7 key inputs 

 DC Supply：USB Powered or External 7V~12V DC。 

 DC Output：5V /3.3V DC and External Power Output 

 Dimensions：90x80mm 
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Arduino control board layout 

 

The picture above highlights some important features of the control board, which includes: 

 One Regulated Motor Power Input Terminal (6v to12v) 

 One Unregulated Servo Power Input Terminal (you supply regulated 4v to 7.2v) 

 One Servo input power selection jumper 

 One Serial Interface Module Header for APC220 Module 

 Two DC Motor Terminals – Handles motor current up to 2A, each terminal 

 One IIC/TWI Port – SDA, SCL, 5V, GND 

 One Analog Port with 8 analog inputs – one input is tied internally to the supply voltage 

 One General Purpose I/O Port with 13 I/O lines – 4,5,6,7 can be used to control motors 

 One Reset Button 

 Jumper bank to Enable/Disable Motor Control 
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Arduino control board pin jumpers 

Servo power select jumper 

As most servos draw more current than the USB power source can supply, a separate servo power terminal is provided to 

power the servo individually which can be Enable/Disable by the Servo Power Select Jumper. 

When the Servo Power Select Jumper is applied, the servo is powered by an internal 5V. 

When the Servo Power Select Jumper is not applied, the servo is powered by an external power source. 

 

Motor control pin jumper 

Applying the Motor Control Pin Jumpers will allocate Pins 4, 5, 6 and 7 for motor control. 

Removing the jumpers will release the above pins. 

 

Wireless select jumper 

Applying the Wireless Select Jumper will allow the controller to communicate via a wireless module such as the APC220. 

If no wireless module is plugged in, this jumper will not make any difference. 

Removing the jumper will disable wireless module and allows the sketch to be uploaded. 

 

Button enable jumpers 

Applying these jumpers will enable push buttons S1 through S7. 
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Powering the Arduino control board 

Applying power 

 

This is one of the most important steps in getting your control board up and communicating with your host controller.  Your 

control board can be powered from its USB port (connected to your computer), from its motor power input or from its servo 

power input.  Power from the USB port will provide the control board with enough power to upload and run sketches, but 

not enough power to drive servos or DC motors; for these applications, power from the servo power input or the motor 

power input is required. 

 

Please note: When applying power to either the Motor Power Input or the Servo Power Input, please ensure you use the 

correct polarity.  Reverse Polarity will damage the controller. We are not responsible for such damage, nor does our 

warranty cover such damage.  Please make sure you take time to apply the power correctly! 

 

Power from the servo power Input: 

Connect the battery to the Servo Power Input. You MUST make sure that you apply power to the Power Terminal using 

the correct polarity (refer to “Arduino control board Layout” on page 15).   

 

Power from motor power input:  Connect the battery to the Motor Power Input. You MUST make sure that you apply 

power to the Power Terminal using the correct polarity (refer to “Arduino control board Layout” on page 15).   

 

From USB: Simply connect your control board to your computer via USB cable, and the controller is able to work. Please 

note that the USB can supply a maximum current of 500 mA. It should be able to meet the most requirements for LED 

applications, however it is not enough to power servos or DC motors. 
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Uploading sample code to the Arduino Control Board 

For this section you will need: 

 Arduino IDE (Integrated Development Environment) software 

 The FB004 sample code 

The Arduino IDE (Integrated Development Environment) is a piece of software that allows you to write programs on your 

computer and then upload them onto the Arduino control board.  The control board included in this package can be 

programmed using Arduino IDE version 0014 and above. It is included on the CD but can also be downloaded directly 

from the Arduino website at http://arduino.cc/en/Main/Software.   

You will also need the FB004 2WD sample code file.  It is located on the accompanying CD and it is also supplied on the 

Fivebro international website (http://www.fivebro.com.tw) under the support section. 

Once you have downloaded and extracted both of these files, you can execute the file named “arduino.exe” and you will 

be presented with a screen that looks like this: 

 

http://arduino.cc/en/Main/Software
http://www.fivebro.com.tw/
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The next step is to simply connect the Arduino control board to your computer using the USB cable supplied (part #71005). 

 

Please note: The Arduino expansion board cannot be plugged in while uploading any programs. 

 

Using your Arduino IDE software, click File > Open > and then point the browser to the location where you have 

downloaded the FB004 2WD sample code.  The sample code file is called “FB004_2WDSample.pde”. 

After doing so your Arduino IDE software should look like this: 
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Now click Tools > Board > then select “Arduino Diecimila, Duemilanove, or Nano w/ ATMega328”. 
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Next, click File > Serial Port > and then choose one of the serial ports listed.  Ports COM1 and COM2 are usually already 

reserved by your computer, so try COM3 or above. 

Finally upload the program to the board by pressing the  icon.  This will compile the sketch and upload it into your 

Arduino control board.  If uploading is successful your Arduino IDE should look like this: 

 

 
 

If communication with the control board fails, please try selecting a different serial port.  If you still cannot succeed in 

connecting, please refer to the troubleshooting section of the Arduino website at: 

http://arduino.cc/en/Guide/Troubleshooting 
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Tutorials 

Button Press Tutorials  

The controller has 7 build-in buttons, labelled S1-S7. Buttons S1-S5 use analog input, S6, S7 use digital input. 

To enable S6 and S7, apply all three of the “button enable jumpers” (shown on the pinout diagram, page 23). S6 uses 

Digital Pin2, S7 uses Digital Pin3. Once these enable jumpers have been applied, Pin 2 and 3 will be occupied by the 

push buttons. 

 
 
// Sample code 1:  One-button LED switch 

//Code function: Press button S6, LED turns on, press it again, LED turns off. 
 
 

int ledPin = 13;                 
int key_s6 = 2;              
int val=0; 
 
void setup() 
{ 

  pinMode(ledPin, OUTPUT);      // Set Pin13 to output mode 
  pinMode(key_s6, INPUT);       // Set Pin12 to output mode 

} 
void loop() 
{ 

   if(digitalRead(key_s6)==0)  { 
        while(!digitalRead(key_s6)); 
        val++; 
   } 

 
if(val==1)  {  
digitalWrite(ledPin, HIGH);   //  
} 
    
if(val==2)  { 
        val=0; 
        digitalWrite(ledPin, LOW);    // 
} 

} 
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// Sample code 2:  Two-button LED switch 
//Code function: Press button S6, turn on LED, Press button S7, turn off LED. 
  
 
int ledPin = 13;                 
int key_s6 = 2;                  
int key_s7 = 3;      
             
void setup() { 

pinMode(ledPin, OUTPUT);       
pinMode(key_s6, INPUT);        
pinMode(key_s7, INPUT);        

} 
void loop() 
{ 
   if(digitalRead(key_s6)==0)    
     { 
         digitalWrite(ledPin, HIGH);    
     } 
 
   if(digitalRead(key_s7)==0)   
     { 
         digitalWrite(ledPin, LOW);     
     } 
} 
 
 

Dual DC Motor Speed Control 

Hardware Setting 

Connect four motor wires to Motor Terminal. And apply power through motor power terminal. 

 

Pin Allocation 

 

 

"PWM Mode" 

Pin Function 

Digital 4 Motor 1 Direction control 

Digital 5 Motor 1 PWM control 

Digital 6 Motor 2 PWM control 

Digital 7 Motor 2 Direction control 
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"PLL Mode" 

Pin Function 

Digital 4 Motor 1 Enable control 

Digital 5 Motor 1 Direction control 

Digital 6 Motor 2 Direction control 

Digital 7 Motor 2 Enable control 
 

PWM Control Mode  

The PWM DC motor control is implemented by manipulating two digital IO pins and two PWM pins. As illustrated in the 

diagram above, Pin 4,7 are motor direction control pins, Pin 5,6 are motor speed control pins. 

 

// Sample code: Standard PWM DC control 
 
#define LED 13  //pin for the LED labelled "L" 
 
//motor control pins 
unsigned char E1=6; 
unsigned char E2=5; 
unsigned char M1=4; 
unsigned char M2=7; 
 
int incomingByte = 0; // for incoming serial data 
 
 
void setup() { 
 Serial.begin(9600); 
} 
 
void advance() //advance 
{ 

analogWrite(E1,100); 
digitalWrite(M1,HIGH); 
analogWrite(E2,100); 
digitalWrite(M2,HIGH); 
return; 

} 
void back_off () //Move backward 
{ 

analogWrite (E1,100); 
digitalWrite(M1,LOW); 
analogWrite (E2,100); 
digitalWrite(M2,LOW); 

} 
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void stop() //stop 
{ 

analogWrite(E1,0); 
digitalWrite(M1,HIGH); 
analogWrite(E2,0); 
digitalWrite(M2,HIGH); 
return; 

} 
 
 
void loop() { 
 

if (Serial.available() > 0) { 
 

// read the incoming byte: 
incomingByte = Serial.read(); 
 
// say what you got: 
Serial.print("I received: "); 
Serial.println(incomingByte, DEC); 
 
if (incomingByte == 119) {  // press "w" 

advance(); 
delay(1000); 
stop(); 

} 
 
if (incomingByte == 115) { //press "s" 

back_off(); 
delay(1000); 
stop(); 

} 
} 

} 
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IO Expansion Board 

To support RS485 interface or drive 4 motors, IO Expansion Board is available. 

 

 
Arduino control board combined with IO expansion board 



 Fivebro International Corp. 
29 

7. Limited Warranty  

FIVEBRO ONE YEAR LIMITED WARRANTY 

Fivebros warranty obligations for this FiveBOT (this “Product”) are limited to the terms set forth below. 

Fivebro International Corp. (“Fivebro”) warrants to the original end-user purchaser that this Product will be free from defects in 

materials and workmanship under normal use for a period of 180 days from the date of retail purchase (the “Warranty Period”). 

This warranty is extended only to the original end-user purchaser of a new product that was not sold “as is”. 

If a defect arises: 

(1) you may within 1 year  from the date of retail purchase (or such other period specified by the return policies of the place of purchase) return this Product 

to the place of purchase, together with the original proof of purchase and either the original box or the UPC code label from the box, and this Product will be 

replaced or, in the event that a replacement for this Product is not available at the place of purchase, either a refund of the purchase price for this Product or 

an store credit of equivalent retail value will be provided; or 

(2) you may after the day that is 30 days from the date of retail purchase (or such other period specified by the return policies of the place of purchase) and 

within the Warranty Period contact Fivebro Customer Support to arrange for the replacement of this Product. In the event that a replacement for this Product 

is not available this Product will be replaced by Fivebro with a product of equivalent or greater retail value. 

A purchase receipt or other proof of the date of retail purchase is required in order to claim the benefit of this warranty. 

If this Product is replaced, the replacement product becomes your property and the replaced Product becomes Fivebros 

property. If the place of purchase refunds the purchase price of this Product or issues a store credit of equivalent retail value, this Product must be returned 

to the place of purchase and becomes Fivebros property. 

EXCLUSIONS AND LIMITATIONS 

This warranty covers the normal and intended use of this Product. This warranty does not apply: (a) to damage caused by 

accident, abuse, unreasonable use, improper handling and care or other external causes not arising out of defects in materials or 

workmanship; (b) to damage caused by power line surge, lightning or acts of God; (c) to damage caused by service performed by 

anyone who is not an authorized representative of Fivebro; (d) to any hardware, software or other add-on components installed 

by the end-user; (e) if this Product has been disassembled or modified in any way; (f) to faulty installation or set-up adjustments; 

(g) to consumable parts, such as batteries, unless damage has occurred due to a defect in materials or workmanship; (h) to 

cosmetic damage, including but not limited to scratches, dents or broken plastic, or normal wear and tear. Regardless of whether 

the camera is in use or not,exposure to extremely bright lights or objects can damage the CMOS camera sensor. This warranty 

specifically excludes any damage to the CMOS sensor resulting from exposure to extremely bright lights or objects, whether 

accidental or deliberate. 

THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS AND YOU MIGHT ALSO HAVE OTHER RIGHTS THAT VARY FROM STATE 

TO STATE. FIVEBROS RESPONSIBITLITY FOR PRODUCT DEFECTS IS LIMITED TO THE REPLACEMENT OF THIS PRODUCT OR 

THE REFUND OF THE PURCHASE PRICE FOR THIS PRODUCT. ALL EXPRESS AND IMPLIED WARRANTIES, INCLUDING BUT NOT 

LIMITED TO ANY IMPLIED WARRANTIES AND CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, 

ARE LIMITED IN TIME TO THE TERM OF THIS LIMITED WARRANTY. NO WARRANTIES, WHETHER EXPRESS OR IMPLIED, WILL APPLY 

AFTER THE EXPIRATION OF THE LIMITED WARRANTY PERIOD. If any term of this warranty is held to be illegal or unenforceable, 

the legality or enforceability of the remaining terms shall not be affected or impaired. 

EXCEPT AS PROVIDED IN THIS WARRANTY AND TO THE EXTENT PERMITTED BY LAW, FIVEBRO IS NOT RESPONSIBLE FOR 

DIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES HOWSOEVER CAUSED RESULTING FROM BREACH OF WARRANTY 

OR CONDITION OR UNDER ANY OTHER LEGAL THEORY, INCLUDING BUT NOT LIMITED TO LOSS OF USE. THE FOREGOING 

LIMITATION SHALL NOT APPLY TO DEATH OR PERSONAL INJURY CLAIMS, OR ANY STATUTORY LIABILITY FOR INTENTIONAL AND 

GROSS NEGLIGENT ACTS AND/OR OMISSIONS. 

SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, OR 

LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, SO THESE LIMITATIONS MIGHT NOT APPLY TO YOU. 

Valid only in R.O.C. and U.S.A. 
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Manufactured and distributed by 2010-2011 Fivebro International Corp. 
Product names, designations, and logos are trademarks or registered trademarks of Fivebro International 
Corp. All right reserved. 
 
Fivebro International Crop. 
1105 Room, 11F, No. 206, Song Jiang Rd., 
Taipei City 10467, Taiwan, R.O.C. 
Email: sales@fivebro.com.tw 
Web: www.fivebro.com.tw 
 
Customer service line: +886 2 2562 8445 
Customer online support: http://www.fivebro.com.tw/ and navigate to the “support” section.  
 
We recommend that you retain our address for future reference.  
Product and colors may vary. 
Printed in Taiwan. 
This product is not suitable for children under 3 years 
 
This user manual should be kept as it contains important information. 

mailto:sales@fivebro.com.tw
http://www.fivebro.com.tw/
http://www.fivebro.com.tw/

